UNIVERSITY OF NEW SOUTH WALES
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TUTORIAL INTRODUCTIONS TO CAD

AUTOCAD 2000 — A RESIDENTIAL SITE PLAN

Jim Plume

This is the second in a series of tutorial introductions to CAD. The general aim
of these tutorial guides is to give you a firm conceptual understanding of CAD,
including the scope of techniques available for design and presentation, and
strategies for approaching a variety of drawing tasks. This tutorial concentrates
on 2D drawing, using a simple residential site plan to explore the range of basic
techniques for producing and locating accurate linework. It ignores concepts
like layering, but does introduce most drawing and editing tools and the
manipulation of object properties. The final drawing is shown at the end of this
handout.

These tutorials are written for AutoCAD 2000 running under the Windows 95/98
operating environment. Some of the later tutorials make use of enhancement
packages that are sold in conjunction with AutoCAD to address specific
disciplinary CAD modelling tasks. This tutorial was developed using the
Architectural Desktop package, but only uses AutoCAD 2000 features and tools.

Architectural Desktop 2.0

GETTING STARTED

Start up AutoCAD 2000. In the Startup dialogue box, use the Wizard with the
Advanced Setup option as shown in the following dialogue box to create a new
drawing. This option will walk you through the initial steps necessary to set up a
new drawing, showing you each of the standard settings that AutoCAD uses.
Some of these will suit us, while others we will wish to change.

H]

.I uick Setup

—*izard Description

Setz the units, angle, angle meazure, angle direction, and area for your new
drawing. Bazed on the template acadizo. dit,

¥ Show Startup dialog Ok I Cancel
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Drawing Units

Decimal units with precision 0.

Angle Measurements

Decimal angles with precision 0.0

Base Angle

North

Angle Direction

Clockwise

Drawing Area (Limits)

60000 x 60000

G

Zoom All Tool

Save the Drawing!!

Click the OK button to go to the first screen that allows you to set up the units to
be used in your drawing. If you select each alternative in turn while watching the
small graphic image, you will quickly appreciate why we use the first option
labeled Decimal. Re-select Decimal and set the precision to 0 since it is
meaningless to work with building geometry in fractions of a millimetre. Then
click the Next button to move to the next screen.

Again, check out each of the options here, particularly noting AutoCAD’s
interpretation of surveyor’s units. In Australian practice, surveyors express
bearings in degrees (0-360) measured clockwise from north. We may be
tempted to use the second option (degrees, minutes & seconds) but that is only
typically used for site bearings, while we will use decimal measures in all other
drawing actions. Select Decimal angles with a precision of 0.0 and then click
Next to continue.

This option allows us to review the AutoCAD convention that angles are
measured relative to 0 which is assumed to be an Easterly direction. This
follows the normal computer graphics convention where the positive X-axis is
taken as zero. | normally recommend not changing this convention, but since
our first task in this drawing is to draw the site boundaries (which are normally
read directly off a survey plan) select the North option to make angle 0 “up the
page”. Then select Next to continue.

The normal AutoCAD practice again follows computer graphics convention
where the counterclockwise direction is taken as positive. This conforms to the
“right-hand-rule” where, if the thumb is pointing in the positive direction along the
axis, then the fingers point in the direction of positive rotation. Again, | normally
leave this option at the AutoCAD default of counterclockwise, but on this
occasion, since surveyors measure boundary bearings clockwise from North,
select the Clockwise option before clicking Next to continue.

Since our site is about 45 metres long, it would be sensible to make our drawing
area about 60000 mm square. Notice from the example provided that AutoCAD
assumes we work in metres, while the Australian convention is to work in
millimetres. Set both values to 60000 and then click Finish. That completes our
drawing setup and AutoCAD displays the normal editing screen.

As you move the mouse around the screen, note the coordinates displayed in
the lower left corner: AutoCAD is still only displaying the default drawing area of
420x297. We use the Zoom All command to expand the view to “see” the whole
drawing area.

[Standard. Issue the command Zoom with the option All - check out

Zoom All] the Command Window to see the way AutoCAD prompts
you as you enter this command and then enters the
response by itself!! Remember, the Button Tools can be
programmed to execute several commands, including all
the necessary responses in order to perform quite complex
operations.

Click the Save button and then navigate to your student folder and save this
drawing under an appropriate name.

DRAWING THE SITE BOUNDARY

The final drawing on the back sheet of this handout shows the boundary
bearings much as they would be shown on a typical survey plan. The lengths
are shown in metres, and the bearings in degrees, minutes and seconds relative
to North (which is also assumed, for the sake of this exercise, to be off to the
right rather than exactly “up-the-page”). Take a moment to study those
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User Coordinate Systems (UCS)

All graphics objects in AutoCAD are
modelled in relation to a fixed
World Coordinate System with a
global origin at the bottom left
corner of the drawing area and the
X-axis pointing to the right and the
Y-axis pointing directly up the page.

At any time, a user can set up a
temporary User Coordinate
System by moving the origin
and/or rotating the axes. All data is
then entered relative to that
temporary axis system, but is
converted automatically and stored
in World Coordinates.

—

Polyline Tool

bearings, making sure that you understand each one. Naturally, the value of the
bearing depends on which end of the boundary line is considered to be the
“start”. In this fictitious site I've deliberately mixed that up a little! North on this
drawing is actually 230 off towards the right as shown.

Rotating the Drawing Axes

The easiest way to draw the site boundaries is to begin by rotating the drawing
axes so that the Y-axis (“up-the-page”) is pointing in the exact direction of North
on the plan. Remember that we have already altered the AutoCAD convention
(temporarily) so that “up-the-page” is considered 0° and angles are measured
clockwise. Therefore, all we have to do is rotate the axes through 239 while we
draw the site boundaries and the north arrow. We do that by temporarily setting
up a new User Coordinate System (or UCS).

Tools > New Use the pull-down menus to issue the New UCS command
UCS>Z with the option to rotate the axes around the Z-axis (which
is an imaginary axis that comes out of the screen).
230 Type the value of the angle of rotation followed by the

Enter key to complete the command. Notice that the UCS
icon in the lower left corner of the screen has changed to
indicate the new axis direction.

We now use the Polyline command to draw the four boundary lines. A polyline
is an entity that is made up of a series of straight line or arc segments but is
treated as a single entity in AutoCAD. If you use the Line command, each
boundary line will be treated as a separate entity. Although that does not matter
particularly, it seems sensible to make them one object.

Select the button illustrated from the Draw toolbar ... notice
the prompt on the Command Line ... pick a starting point
with the mouse pointer near the bottom of the drawing area
about one-third along from the left.

[Draw.Polyline]

To enter the four boundary lines, we use AutoCAD'’s coordinate entry technique.
In this case the coordinates are relative (indicated by the prefix “@”) polar
values. That means that we specify the length and angle of each line
(separated by the “<” symbol) relative to its starting point. While we would
normally specify angles in decimal form (eg 327.3), it is convenient here to use
the “degrees/minutes/seconds” format since we can read that directly off a
survey drawing. Notice also that the third entry is a “back bearing”. That is, the
original bearing was taken from the SE corner of the site whereas we are
drawing the line from its other end. Rather than re-calculate what the bearing
should be, we simply enter the length as a negative number so that AutoCAD
constructs the line in the correct direction. Finally, the last line is drawn using
the “close” option (abbreviated to “c”). This ensures that the polyline closes
correctly. If we wished to test the surveyor’s accuracy, then we could draw the
last line (@-19400<67d) and measure the distance between the two points!

@37258<327d19'48" [
@26654<51d19'48" [
@-43928<337d O

c O

Before proceeding, we need to revert back to AutoCAD’s “normal” convention of
measuring angles counterclockwise from 0 taken as an easterly direction. We
do this because all the other tutorials follow that convention and we may as well
get used to it!
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Object Snap Flyout on the
Standard toolbar ...

.

Perpendicular Snap Mode Tool in
the Osnap Flyout shown above ...

Format > Units | Select from the pull-down menus ... in the resulting
dialogue box (illustrated at left) de-select the Clockwise
checkbox and then click the Direction button to open
another dialogue where you can select the East option ...
then click OK to dismiss each dialogue in turn.

Before going any further, we need to turn off some of the AutoCAD snapping
tools so that they don’t confuse you as you learn the basic techniques first.
Look at the row of Toggle Buttons on the Status Line across the bottom of the
AutoCAD Window as illustrated below.

SNAP| GRID| ORTHO|[POLAR [OSMAP [OTRACK. LwT/[MODEL

You should simply go along and click each of the first three buttons that are
currently “depressed” (that is, turned on) so that each appears as a raised
button and therefore is inactive. These are POLAR, OSNAP and OTRACK. Do
not turn off the MODEL button at this stage. We will progressively turn each of
these back on again as we learn how each one works to make drawing easier.

Drawing the North Arrow

Now, with the axes still rotated through 239, we can construct the North arrow
symbol. We will use some more examples of coordinate entry to illustrate that
technique and then have our first taste of using the Text tool to write the word

“North”. We will also introduce Object Snapping.

[Draw.Line] Issue the Line command from the Draw toolbar ... pick a
suitable starting point for the lower end of the arrow line.

@0,7000 O Type the coordinates at the prompt in the Command
Window ... this time it is a relative cartesian coordinate,
telling AutoCAD to draw O units in the X-direction and
7000 in the Y-direction relative to the current (rotated)
UCs.

@-1300,-1300 O Another relative cartesian coordinate, but using negative
values this time to construct the line we want.

[Osnap. Select the Perpendicular Object Snap mode (illustrated)

Perpendicular] from the Osnap flyout toolbar (also illustrated) ... this
may be found in the Standard toolbar below the pull-
down menus ... if you then move the mouse pointer over
the first line we constructed in this sequence a yellow
snap symbol will appear indicating that AutoCAD is ready
to snap to that line using the Perpendicular snap mode,
thus creating a line exactly perpendicular to the line
selected ... click the left mouse button with the snap
symbol visible to complete the snap operation.

O Press the Enter key to complete the command.

The next step is to create a new text style to write the word “NORTH”. Select
Format > Text Style from the pull-down menus to bring up the Text Style
Dialogue box illustrated over the page. Once the dialogue is visible, click the
New button to create a new style. Type a name for the style (I called mine
“NorthPoint”) and press OK. Then select a font from the pull-down list (I used
Arial Black which is a “thicker” version of the normal Arial font and good for
headings and the like). Finally, specify the height as 1000. In AutoCAD text
height is always expressed in drawing units relative to the size of real-world
objects in your drawing. In selecting the text height, think about the likely scale
to be used when plotting the drawing. In this case, we will be plotting at 1:200
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Endpoint Object Snap tool
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Move Tool

scale, so this text will end up being 5 mm (1000/200) high on the drawing. You
can always change text height at any time ... it is simply a “property” of that text
object. Note that you can change other features of the text by applying some
quite unique “effects”. It turns out that AutoCAD text is more versatile than
many of the very sophisticated desktop publishing applications.

— Style Name Apply I
WorthPoint j Mew... Rename. .. Delete | Close |
— Fiont Help |
Font Mame: Font Shle: Height:
I'ﬁ‘ Aial Black =] IHegular j |1 00cf
= e Big Eart
— Effects — Preview
I™ Upside down ‘width Factor: |1
[ Backwards Oblique Angle: I':'-':' —Aam
= Hertical W Breview |

We will use the Single Line Text command to write this text. This command is
NOT available on the toolbars, but may be accessed through the pull-down
menus (Draw > Text > Single Line Text) or as a typed command word. We will
use the typed command this time.

dtext O

Issue the Single Line Text command (also called dynamic
text) ... AutoCAD prompts for the starting point of the text.

[Osnap.
Endpoint]

Use the Endpoint snap mode to lock onto the lower end of
the arrow line that we created.

[Osnap.
Endpoint]

Use the Endpoint snap mode again, this time to indicate
the direction of the text ... snap onto the other end of the
main arrow line ... this means that the text will be
constructed as shown in the final drawing ... AutoCAD next
prompts for the text itself ...

NORTH O

Type the text required and press the Enter key.

O

Press the Enter key to complete the command ... the next
step to move the text slightly so that it is just above the
arrow line ...

[Modify.Move]

Issue the Move command (illustrated) from the Modify
toolbar ... notice the prompt says “Select Objects” ... click
on the text object just created ...

Press Enter again to complete the object selection process
... AutoCAD now prompts you for the first of two points to
describe how you want to move the text object ... click any
position to act as the “base point” of the move ... then
move the mouse around until the text is neatly positioned in
relation to the arrow and then click the left mouse button
again.
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Note that there is no toolbar tool for
Single Line Text in AutoCAD as it
comes shipped from the factory ...
the tool in the Draw toolbar is
Multiline Text ...

That completes the arrow. Before moving to the next stage, you need to rotate
the axes back to normal. You do that simply by setting the UCS back to “world”
by selecting from the pull-down menus: Tools > New UCS > World.

This is a good time to Save your drawing ready for the next stage in this tutorial.

Labeling the Site Boundaries

Adding text to the boundaries is very similar to adding the text to the north
arrow. The trick is lining up the text with the boundary line and, again, we can
use snap modes to do that. Rather than enter each snap mode as we need it,
AutoCAD allows us to set up “running object snaps” which offer themselves
automatically as we get near the point. We will try that method now!

Place the mouse pointer over the OSNAP toggle button on the Status Line and
click the right mouse button. In the pop-menu, select Settings. That will bring
up the dialogue illustrated on the left. Make sure that the three snap modes
Endpoint, Midpoint and Nearest have been selected as shown, and then click
OK. Now left-click the OSNAP toggle button to turn on running object snap.
Also note the symbol next to each snap mode in the dialogue box: these are
used on the drawing to show when AutoCAD has found a suitable snap point.

Now, set up a new text style. | called mine “BoundaryText” and used the
standard AutoCAD text font called Simplex (an old favourite!) and set the text
height to 400. You can vary that if you wish for your drawing! Note that Simplex
is one of the native text fonts in AutoCAD. These are vector fonts (no solid fill
like the Windows True Type fonts) and are quick to draw and useful for general
notes and annotation. They are easy to identify because they have a different
icon than the True Type fonts.

Issue the Single Line Text command (from the pull-down menus or type the
command, dtext). Check that AutoCAD is going to use your new style by
checking the prompt. If not, use the Style option to change the “current style”.
AutoCAD then prompts for the starting point of the text. Starting with the west
boundary, move the mouse around noting that as you get near the ends of the
line, the Endpoint snap locks in. Right at the midpoint of the line, the Midpoint
snap will become activated. Otherwise, as you get near any other point on the
line, the Nearest snap mode will operate. All these snap modes will lock onto
the line, so you can pick any you like to lock the starting point on the line. When
AutoCAD prompts for the text direction, again use the running object snaps to
lock onto the line in the direction you wish the text to follow. When AutoCAD
prompts for the text itself, enter the west boundary text as follows:

37.258 m 327%%d19'48"

Note the use of the string “%%d” to represent the degree symbol. This is a
special code recognised by AutoCAD as part of its text entry features. There
are other similar codes for representing special symbols that you can find in the
Help system. Press Enter a second time to complete the command.

Now enter the remaining boundary labels as shown on the final drawing at the
end of this tutorial.

DRAWING THE CONTOUR LINES

AutoCAD is surprisingly tolerant when supporting the input of coordinate
information. We have already seen how coordinates can be typed at the
keyboard for accurate data entry. Since contour information is often obtained
directly from a Surveyor in electronic form, we are going to demonstrate how
you can very easily import such data from any file that contains the data in some
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text form. Without actually knowing how this text data might come from a
Surveyor, | have simply created a text file that contains the critical points that
define the contours for this site. We are going to cut and paste that information
into AutoCAD.

Open the file called “ContourPonIines.txt"lin the following folder on the Faculty's
Server:

Resources on ‘Emuwater’ (R:)\Samples\benv\CAD Files

In that file you will notice that | have created a list of the points that define each
contour. The first point is expressed as a 3D coordinate where the Z-value is
the height of the contour (above some local datum point). The remaining points
are 2D coordinates. Although this is only a 2D drawing, it seems worthwhile to
enter the contours at their correct height relative to each other as this would be
useful if we wanted to use this drawing as the basis for a terrain model at some
future time. The XY values of all these points are relative to a base point on the
site. In this case, that base point is the lower left (SW) corner of the site, but in
reality would be whatever datum the surveyor established for the site.

The following steps detail the process, but | begin with a quick overview. We
begin by positioning the UCS at the base point and then use the Polyline
command to draw the contours. Since polylines are 2D entities in AutoCAD,
they are constrained to always lie in the same XY plane. That means that by
specifying the height of the first point on the polyline, all the other points are
forced to have the same Z-value. We then edit the polyline to fit a smooth curve
through those points.

[UCS.Origin] Click the UCS Origin tool (illustrated) from the UCS flyout
(also illustrated) on the Standard toolbar ... move the
mouse pointer to the SW corner of the site and AutoCAD
will snap to that point because running object snap is still
selected ... the UCS icon will then be positioned at that
point as a visual indicator of the location of the origin.

[Draw.Polyline] | Issue the Polyline command ... AutoCAD will prompt for
the Starting Point. Switch to the “ContourPolylines.txt” file
(which you probably opened in Notepad) and highlight the
full list of coordinates for Polyline 1 ... press [Cntrl-C] to
cut that text (or use the Edit menu) and then return to
AutoCAD ... be careful to click the mouse in the Command
Prompt area so that you have a flashing text cursor on the
command line and then press [Cntrl-V] to paste the text
(do not use the pull-down menu in this case as it will paste
the text into your drawing as a text object!).

] Press the Enter key to complete the command.
Modify > Select from the pull-down menus ... select the polyline just
Polyline drawn in response to the prompt ... note the long list of

editing options that you can apply to a polyline ...

fO Select the Fit option ... AutoCAD fits a smooth curve to the
polyline, ensuring that it passes through each point.

O Complete the Polyline Edit command.

Repeat that process to draw each contour. Then click the UCS World tool
(illustrated) to switch back to world coordinate space. To do that you will need
to pull down the UCS flyout because each time you use a flyout, AutoCAD
places the most recently-used tool at the “head” of the flyout so in this case, it
will be the UCS Origin tool that we used most recently!

Last Updated: March 2000 Drawing with AutoCAD 2000 — Residential Site Plan



http://www.fbe.unsw.edu.au/Learning/autocad/R2000/ContourPolylines.txt

Snap and Giid  Polar Tracking | Dbject Snap

I Bolar Tracking On (F10)
Polar Angle Seling: |- Dbject Snap
Incremen t ange:  Track othogonaly orly

Polar Tracking dialogue ...

—

Polyline Tool

From tool in the Osnap flyout ...

DRAWING THE BUILDING OUTLINES

Next, we will draw the main building outline along with the dotted gable roof
lines. This will permit us to explore the use of polar tracking techniques for
quick and accurate input of coordinate geometry.

Begin by setting Endpoint & Intersection as the running object snaps and then
right-click on the POLAR toggle key on the Status Line (to open the pop-up

menu) and select Settings to open the Polar Tracking dialogue (as illustrated).
Enter values in the dialogue as illustrated, including the Polar Tracking On check
box. Then click OK.

[Draw.Polyline]

Issue the Polyline command from the toolbars ... AutoCAD
prompts you for a starting point ... we assume that we
know the position of the SW corner of the building relative
to the SW corner of the site (which we will take as the
datum point for this site) ... we can specify that position
using the From snap mode as follows ...

[Osnap.
Snap From]

Select Snap From tool (as illustrated) in the Osnap flyout
... use Endpoint running object snap to lock onto the SW
corner point of the site ...

@100,10000 O

Type this relative coordinate at the prompt ... this tells
AutoCAD to begin the polyline at this position relative to the
point selected ... now move the mouse until the tracking
line is shown heading “right” from the starting point ...
leave the mouse in that position and type ...

6000 O

This tells AutoCAD to draw the line this distance along the
tracking line ... next, position the mouse so the tracking
line is “up” from the end of that line and then type ...

2000 O

This draws the line this distance from the last position
along the tracking line ... repeat this process to enter each
segment of the building outline: 4500 (right); 4000 (down);
7000 (right); and 10000 (up) ... this takes us to the NE
corner of the building ... to draw the north face we want the
line to end up in line with the SW corner of the house ... to
do that we use Object Snap Tracking in conjunction with
Polar Tracking ...

[OTRACK]

Click the OTRACK toggle button on the Status Line ... now
move the mouse pointer so that it passes over the SW
corner of the building ... the Endpoint snap symbol should
appear at that point and as you move away again (moving
“up”) a tracking line should appear passing through that
shap point ... as you then move towards the position of the
NW corner, two tracking lines should appear (one vertical
from the SW corner and the other horizontal from the NE
corner) with an Intersection symbol at their point of
intersection ... when you see that intersection symbol, click
the left mouse button ... the line should then be drawn to
the point of intersection of the two tracking lines ...

cO

Type “c” for close ... this will complete the polyline by
drawing a line back to the starting point.

That simple outline showed you how to use both Polar Tracking and Object
Snap Tracking. It is important that you understand both techniques, as we will
use them all the time from now on!
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In the final plotted drawing, we want this outline to be drawn with a heavier line
weight than other objects in the drawing. We can do that by assigning a line
weight property to it. First select the polyline by clicking on it with the left mouse
button. It should appear as a dotted line with blue “handles” at each corner and
at the midpoint of each edge (to show that it has been selected). Next, pull
down the list of line weights as illustrated. Scroll down the list until you see 0.70
mm and click on that. The line will now be plotted in that thickness, though it
appears normal on the screen. To preview lineweights on the screen, click the
LWT toggle on the Status Line. | find the displayed line weights are often
exaggerated and it is best not to have them displayed when working with the
drawing.

Adding the Roof Form

The next step is to draw the roof line offset 450 mm from the edge of the
building outline.

&

450 O

Select the Offset tool from the Modify Toolbar ... AutoCAD
prompts for an offset distance ...

Enter an offset distance of 450 being the roof overhang ...
click on the building outline in response to the prompt ...
then point anywhere outside the polyline to show the
direction of the offset ... AutoCAD should create a new
polyline 450 outside the original one.

Note that the new offset polyline also has a line weight of 0.70 mm (inherited
from the line used to create it). Change its line weight to “By Layer”.

The next step is to simplify the roof shape over the entry area at the front of the
house (compare your roof outline to the final drawing!). Use the Zoom Window
command (tool button illustrated from the Zoom flyout) to zoom in on that part of
the drawing. Using the figure on the left, follow these steps ...

Issue the Explode command (tool illustrated) and pick the
J roof polyline just created ... this breaks the polyline down
into separate line entities.

Issue the Erase command and pick the two lines shown
dashed in the figure on the left.

&

r.—"— Issue the Fillet command ... this command joins two lines

with a small fillet arc ... note that the fillet radius is initially
set to 10, while we want the radius to be 0 so that the two
lines join at a point with no fillet arc.

rQd Select the Radius option to change the fillet radius ...
o0 Set the fillet radius to zero.
a Press Enter again to recall the Fillet command ... this is a

useful shortcut in AutoCAD ... pressing Enter in response
to the Command prompt always recalls the most recent
command used ... pick the two lines to be joined at the
positions shown in the diagram

Use the Zoom Previous command to get back to the
previous view.

Use the Zoom Window command to zoom in on just the
outline of the main building just drawn.

O,
S
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A note about the Global Linetype
Scale Factor set in this
paragraph ...

| have never quite understood how
the linetype scale factor works and
always find the correct scale factor
for each drawing by trial and error.
If the scale factor is not set
incorrectly, then the dashed lines
will be either too short or too long to
show on the drawing so the line
appears to be continuous. | have
found it best to start with a factor of
about 10 and increase it upwards
until the dashed lines appear
correct. The “correct” value for this
drawing turned out to be 25.
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Perpendicular Snap tool

The next step is to draw the roof ridge lines. If you set the Polar Tracking angle
to 450 and turn on POLAR, OSNAP and OTRACK, then you will find that you
can create all those lines (see final drawing) without having to type any values,
compute any geometry or use any editing commands. Use only the Line
command with Endpoint snapping to lock onto existing points and the
intersection of two tracking lines to position each of the ridge points.

We now want to make all those lines into dashed lines. Begin by pulling down
the list of line types and selecting “Other...". In the resulting dialogue box, click
the Load button. This will open a dialogue with a list of pre-defined line types
that can be loaded into the drawing. Scroll down the list and look at the range of
styles available. For simplicity, | loaded all the line types from “BATTING”
through to “ZIG ZAG” at the very end of the list. To do that, first select
“BATTING” then scroll to the end of the list and hold down the Shift key while
selecting “ZIG ZAG”. That will highlight all those styles. Then click OK. Before
leaving the Linetype Manager dialogue, set the Global Scale Factor to 25 (see
lower right corner!). This will make your linetypes about the right size on your
drawing. Click OK again to close that dialogue box.

Now select all the roof lines just created by left clicking them. When each one is
highlighted, simply pull down the list of line types again, scroll down to the
“Dashed” type and select it. That will change each of the roof lines to a dashed
line as shown on the final drawing.

Adding the Front Porch

The next step is to draw the front porch and steps (as shown illustrated). Study
the final drawing first, noting that the porch comes out to line up with the front of
the house on the east side and has three steps leading down to the driveway
next to a small garden plot adjacent to the house.

Draw a line beginning at point @ in the figure extending 750 to the east and then
south to line up with the front of the house using Polar Tracking and Object
Snap Tracking. Draw the third line to snap to the corner of the house as shown
at ®. Next, draw the first step beginning at point @, extending 250 west, 1200
north and finishing using the Perpendicular snap mode to link back to the porch
line. We will now use multiple copy to draw the last two steps ...

[Modify.Copy] Issue the Copy command ... pick the three lines just drawn
':'.E_S:l as the top step and then press Enter to complete the
Copy tool selection process ...

m O Select the Multiple option because we want to produce two
copies ... use running Endpoint snap to place the base
point at @ and then position the mouse to set up a tracking
line to the west of the base point ...

250 0 To specify the distance along the tracking line to the first
copy ...

500 O To specify the distance along the tracking line to the
second copy.

O Press Enter to terminate the command.

Draw the rest of the garden bed by drawing the line from the corner of the steps
(point @) 1000 mm west and then back to the house outline using the
Perpendicular snap mode. Finally, zoom out a little and draw the driveway line
from point ® and then perpendicular to the site boundary.
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Parallel Snap tool

_.II.I,."

Extend tool from the Modify toolbar

Save tool ...

To draw the left edge of the driveway, we use the new Parallel snap mode.
Begin the line at the SW corner of the building and then select the Parallel snap
mode (illustrated) from the Snap mode flyout. Pause the mouse pointer over the
west boundary line until the Parallel snap symbol appears and then move the
mouse back towards the east until a tracking line appears parallel to the side
boundary. Using that tracking line, pick a point just short of the south boundary
(you can'’t snap to that boundary in this operation). We will now use the Extend
command to extend that line accurately to reach the boundary line.

[Modify.Extend] | Issue the Extend command ... first pick the boundary line
as the bounding edge ...

a Press Enter to complete the selection of boundary edges
... then pick the driveway line we just constructed ...
AutoCAD should extend it to reach the first bounding edge
it finds ...

] Press Enter again to complete the command ... note that
with this command you can select several bounding edges
and extend several lines to meet those bounding edges.

That completes the main building. You should now apply all the same
techniques to draw the second building by yourself. It is actually a granny flat
and is the subject of the next tutorial where we draw up an architectural plan of
this granny flatl. The SW corner of the granny flat is positioned at —2000,24500
relative to the SW corner of the site. It's dimensions, working counterclockwise
from that point are: 5500 (east); 1200 (north); 3500 (east); 4500 (north); and
then west and south to close the shape. Place the roof over it without any end
gables as shown on the final drawing.

This would be a very good time to save your drawing if you have not been doing
so regularly!

m ]
oo

Array copy tool in Modify toolbar

OUTDOOR ENTERTAINMENT AREA

This section deals with the area around the pool and includes several new
drawing techniques. We begin with the pergola.

Drawing the Pergola

Zoom in on the area around the NE corner of the main house. We have used
Perpendicular snap a few times now. It would be sensible to add it to your list of
running object snaps: Endpoint, Midpoint, Intersection and Perpendicular.

Begin by drawing a polyline from the NE corner of the house using Endpoint,
extending 3500 (north), then 50 (west) and then using Perpendicular snap mode
to draw back to the face of the house. We then use the Array command (for
large multiple copies) to duplicate this single joist as follows ...

[Modify.Array] Issue the Array command ... in response to the prompt,
pick the polyline just drawn to represent one joist ...

O Press Enter to complete the selection process.

] Press Enter again to select the default rectangular array.

a Press Enter again to select the default of 1 row.

14 0 Number of columns in this single row array of copies.

-450 0 A negative spacing will generate the copies to the left.
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Mirror tool

7{..

Trim tool

&)

Zoom Window tool

£

You should now have 14 joists arrayed across the back of the house as in the
completed pergola shown below. We now need to add the edge beam and a
couple of columns to support the joists (I realise that we probably need at least
one more post, but that would spoil the symmetry so | left it out!). We will then
trim the edge beam so that it appears to be under the joists.

E:

A

am
The Finished Pergola

Draw the edge beam as another polyline, beginning @-150,-200 from the NW
corner of the west-most joist, making it 6200 long and 50 wide (towards the
south). Draw the post on the west side as a 150x150 rectangle, crossed to
show that it is a timber post. To duplicate the post, we use mirror copy ...

[Modify.
Mirror Copy]

Issue the Mirror Copy command ... in response to the
prompt, pick the rectangle and two crossing lines just
drawn to represent the post ...

Press Enter to complete the selection ... AutoCAD prompts
for the axis of the mirror ... we will show that by picking two
points ... move the mouse pointer along the edge beam
until the Midpoint symbol appears (a yellow triangle) and
click that position ... then move the mouse down along the
vertical tracking line, noting the position of the mirror copy
... pick any point along that tracking vector.

Press Enter again to accept the default which is NOT to
delete the original, so keeping both the original post and its
mirrored copy.

[Modify. Trim]

Issue the Trim command ... AutoCAD prompts you to
select the objects to be used as cutting edges ... in our
case that will be all the joists ... to pick them in a single
action, proceed as follows ...

cO

Type “c” to indicate we wish to select the objects using a
crossing window ... then pick any two points that form the
opposite corners of a rectangle that crosses every joist but
does not enclose or cross any other graphic entity ... only
the joists should become selected and highlighted ...

Press Enter to complete the selection of cutting edges ...
AutoCAD now prompts you to pick the lines to be trimmed
... you need to pick each small segment of line that has to
be trimmed away, that is, where each joist crosses the
edge beam ... it is best to use Zoom Window to enlarge an
area including 5 joists, pick all those, and then pan across
to the next 5 joists, trim them and so on ... the Zoom and

Pan tool Pan commands are both “transparent”, meaning they can
be executed while another command remains active ...
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Origin UCS tool

(|

Rectangle tool

-

Fillet tool

] When all the lines have been trimmed, press Enter to
complete the command.

Drawing the Swimming Pool

We will draw the swimming pool and spa by constructing two rectangles
precisely placed relative to the site origin (SW corner). We will then fillet those
rectangles to create the rounded corners, offset them to make the ledges inside
the pool and then do some editing in the spa area to clean it all up. There are
many tricks to be learnt in this process.

[UCs. Issue the Origin UCS command and use Endpoint snap to
Origin UCS] place the origin at the SW corner of the site ...
[Draw. Issue the Rectangle command.
Rectangle]
18000,22300 O | Enter the starting point of the rectangle as an absolute
coordinate.
@-4000,7000 O | Enter the opposite corner of the rectangle as a relative
coordinate.
a Recall the Rectangle command ... use Endpoint to put its

starting point at the NW corner of the first rectangle.

@-1920,-20000 | Use relative coordinates to enter the opposite corner of the

spa.
[Modify.Fillet] Issue the Fillet command.

rQd Select the Radius option ...

400 0O Set the radius to 400 ...

O Recall the Fillet command ...

p O This time, select the Polyline option ... since the rectangle

is actually a closed polyline, we can use this option to fillet
all the corners of the polyline in one action ... simply click
on the large rectangle.

STEP 1

Erase the five fillet arcs and two
lines shown in this figure ...

Recall the Fillet command a second time and fillet all four corners of the spa
rectangle. Next, offset each rectangle inward by 80mm. Then use the Explode
command to convert all four rectangles to separate lines and arcs so that we
can edit them. Finally zoom in on the area shown in the next figure in order to
clean up the area between the spa and the main pool.

The first step (illustrated at left) is to use the o)
erase command to remove the lines and

arcs shown dashed in the figure. © /

The second step (illustrated in the figure on i
the right) uses the Fillet command to clean ©
up the drawing as follows. Begin by using a

fillet radius of 400 to fillet the two points

labeled ®. Then use a fillet radius of O to @y
fillet the line and the arc labeled @. Finally © @
to fillet the two pairs of lines labeled ® and
@, we need to first determine the correct
fillet radius for these “inside arcs”. To do that, select any of the other inside arcs
(such as the one marked ®) using the left mouse button, and then right click it
and pick Properties from the pop-up menu. That will open the Properties

O] o
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Real-Time Zoom and Pan

O
Real-Time Zoom tool

This tool allows you to zoom in and
out of your drawing dynamically.
Simply position the mouse pointer
anywhere on the screen and, while
holding down the left button, move
up to zoom in and down to zoom
out.

E Real-Time Pan tool

This works in a similar way,
allowing you to drag your drawing
across the screen while holding
down the left button.

At any time during these
operations, you can use the right
mouse button to switch between
Pan and Zoom or to Exit the
command. You can also press
[Esc] to exit either command.

5

Boundary Hatch tool

window showing all the details of that arc including its radius. Set the fillet radius
to that value and then fillet the two pairs of lines labeled ® and @.

Now use the real-time Zoom and Pan tools (explained in the left margin) to
zoom out to a view where you can see the whole of the pool and spa area.
Then, using the Polyline Edit command (Modify > Polyline), we will join up the
three rounded shapes that form the pool and spa to convert them back into
polylines. You will need to use the command three times. Each time, first pick
one of the lines or arc that forms the shape. AutoCAD will prompt you saying
that the line is not a polyline, but will offer to convert it to one. Answer “yes”.
Choose the Join option in the next prompt and when AutoCAD asks you to
select the objects to be joined to the new polyline, simply pick two points below
and to the left and above and to the right of the whole rectangle (this is called a
selection window). Press Enter to complete the selection process and AutoCAD
will join as many of the selected objects as possible to form the polyline shape.
It doesn’t matter if you selected extra objects in your selection window because
AutoCAD will ignore any objects that do not connect to the polyline it is creating.
Finally, press Enter to complete the command and then use the command again
twice in order to make the other two polylines.

To complete the pool and spa, give the outer polyline shape a line weight of
0.40mm and the two inner shapes a line weight of 0.13mm. Then offset the
outer shape by 400 to create an apron around the pool.

Pool Fence and Paving

By now you should be able to construct the pool fence with only a minimal
amount of instruction! | will give you the key dimensions and a few specific
clues, and leave you to do the rest.

The fence should be drawn as a polyline beginning 6500 west from the NE
corner of the main house. It extends 1200 north, then 3000 west, then follows a
gentle arc to a position about 13000 at an angle of 80° before turning east and
extending perpendicular to the property line. When drawing a polyline, you can
switch between arc and line segments by using the Arc and Line options
respectively. To force the arc to begin in the northerly direction, use the
Direction option and then the polar tracking line to specify the starting direction
of the arc before entering its endpoint using a relative polar coordinate.

Offset the fence line by 150 on either side to create a 300 strip under the fence.

Then set the line type of the fence to something suitable (I used Fenceline2) and
the lineweight of the two adjacent lines to 0.13 so that they fade out a little in the
final plotted drawing.

Now add a similar fence between the house and the boundary line about 1000
south of the NE corner of the house. He pool and spa are now fully enclosed so
we can add the pavement hatching.

Adding the pavement hatching is remarkably simple once the process has been
explained. AutoCAD has a very smart boundary hatching tool that allows you to
fill any bounded shape with a hatch pattern simply by picking a point within that
bounding shape. AutoCAD searches outwards from the pick point to identify
any complex shape. Furthermore, it allows you to pick several bounding shapes
to fill with the one hatch object. That is useful in this case because we want the
hatching to go not only right round the pool, but also to appear between the
pergola timbers and under the roof overhang. AutoCAD includes a wide range
of hatch patterns that are pre-defined, as well as the ability to create custom
patterns from a mixture of cross-hatch lines of any linetype at any angle. You
will pick up some of these options by looking closely at the dialogue boxes as
we go through this process. Begin by clicking the Boundary Hatch tool
(ilustrated) and study the resulting dialogue box.
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The figure (above) shows the boundary hatch dialogue box with the basic
hatching options selected. | have nominated to use a Pre-defined hatch pattern.
| selected Pattern “AR-HBONE" which | chose by clicking the browse button
(circled) next to the Pattern list box. The browse button opens the dialogue
illustrated in the left margin, allowing you to browse through the range of pre-
defined patterns available in the various libraries that come packaged with
AutoCAD. Note that you can add new patterns to the library set, but that goes
way beyond this introductory tutorial. Notice that | have set the scale to 3.

Once you have set the basic options, switch to the Advanced Tag as illustrated

below.

oundary Hatch
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Pick Pointz
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21 | B
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Select Objects

Eemaye &lamnds

" lgnare ”

—

— Object type

IPD|_'.J|iI"|E vl [ Retain boundaries

wiew Selechons

Irherit Properties

— Boundary set

IEurrent wiewuport j Ek_;l Mew

2| Dautle

— |zland detection method

* Flood
" Ray casting

Compozition

' Aszociative

" Nonassociative

Ereswren |

] Cancel Help
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Save tool

On the Advanced Tag, select the Outer option as indicated. This tells AutoCAD
to only hatch around “islands” rather than to hatch the inner parts of islands
which is the Normal option.

Now switch back to the Quick tag and then click the Pick Points button (top right
corner of the dialogue). This returns you to the drawing (temporarily) so that you
can pick points within the boundary you wish to hatch. Pick any point around the
pool first, and then pick points between every joist in the pergola and along
under the eaves line so that you include every boundary. When you think you
have it right, press Enter to return to the dialogue box. Next click the Preview
button to see what the hatching looks like. When ready, press Enter again to
return to the dialogue. If you missed any areas, or you wish to try a different
scale factor, set those things and then preview the hatching again. Repeat that
process until you are happy with the result and then click OK to draw the
hatching.

That almost completes the outdoor entertainment area. There is one more
pavement line to add between the base of the Granny Flat steps and the pool
fence. Add that line into your drawing and then save it before proceeding.

o

Spline tool.

L

Make Block tool

€l] Block D efinition
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ADDING THE TREES

For this exercise, we are going to create one tree that has a canopy spread of
about 1 metre. We will then save that tree symbol as a block and then insert
instances of that block at a variety of scales and rotations to represent the
different trees on this site. By making the block 1 meter is size, we can easily
scale it up to suit any size tree that we wish to represent. | would suggest to you
that that is a good strategy for representing objects like trees in a landscape
drawing.

Begin by going to any clear area of your drawing and constructing a circle that is
exactly 1000 in diameter. Zoom in on that circle and place a second circle in the
centre of the first with a diameter of 100 to represent the trunk. (If your circle is
drawn as a polygon, type in the viewres command, press Enter for the first
prompt and 500 for the second ... this command effectively tells AutoCAD to
represent circles as true circles.) Then use the Spline tool (illustrated at left) to
draw two or three spline curves to represent the foliage of the tree. You will find
it necessary to turn off all running snap and tracking modes while you do this
“sketching”. You can model your tree on the one in the tutorial, or vary it in any
way you wish! Use the 1000 diameter circle to guide you with the size of your
foliage. When you are satisfied with your tree, delete the original 1000 diameter
circle. We are now ready to convert the tree into a block.

[Draw.
Make Block]

Issue the Make Block command ... in the resulting
dialogue (illustrated), set the name of the block and put a
brief description down the bottom ... then click the Pick
Point button ...

[Osnap.
Centre]

Activate the Centre snap mode and click on the small circle
at the centre of the tree ... this defines the insertion point
for the block when this object is placed into a drawing ...
you will be then be returned to the dialogue box ... next,
click the Select Objects button ...

w Type “W” to create a window selection box and then pick
two points that define a rectangle that encloses the whole

of your tree.

O Press Enter to terminate the command and return to the
dialogue box ... click OK to complete the process.
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By default, AutoCAD leaves the block on the drawing. In this case, we don'’t
actually want a 1 metre tree, so just delete the block by picking it and clicking
the Erase tool. Then zoom out so that you can see the whole site.

@ I now want you to complete the drawing by using the Insert Block tool
L (illustrated) to place the following trees on the site at the locations specified
Insert Block tool relative to a datum point at the SW corner of the site. You will need to follow the

prompts carefully and to rotate each tree as you enter it so that they do not all
look too obviously the same!

6.8 m canopy at 11900, 3900
12.6 m canopy at 14650, 37250
7.2m canopy at 2150, 34860
5.0m canopy at 1790,21100

Done!!
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